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Introduction
The Microsoft Office Specialist (MOS) certification program has been designed to 
validate your knowledge of and ability to use programs in the Microsoft Office 2016 suite 
of programs. This book has been designed to guide you in studying the types of tasks 
you are likely to be required to demonstrate in Exam 77-725: Microsoft Word 2016.

See Also For information about the tasks you are likely to be required to demonstrate in Exam 
77-726: Microsoft Word 2016 Expert, see MOS 2016 Study Guide for Microsoft Word Expert by 
John Pierce (Microsoft Press, 2017).

Who this book is for
MOS 2016 Study Guide for Microsoft Word is designed for experienced computer users 
seeking Microsoft Office Specialist certification in Word 2016.

MOS exams for individual programs are practical rather than theoretical. You must 
demonstrate that you can complete certain tasks or projects rather than simply 
answer questions about program features. The successful MOS certification candidate 
will have at least six months of experience using all aspects of the application on a 
regular basis; for example, using Word at work or school to create and manage doc-
uments, format document content, present information in tables and lists, insert and 
format pictures, create business diagrams, and reference information sources.

As a certification candidate, you probably have a lot of experience with the program 
you want to become certified in. Many of the procedures described in this book will 
be familiar to you; others might not be. Read through each study section and ensure 
that you are familiar with the procedures, concepts, and tools discussed. In some 
cases, images depict the tools you will use to perform procedures related to the skill 
set. Study the images and ensure that you are familiar with the options available for 
each tool.
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How this book is organized
The exam coverage is divided into chapters representing broad skill sets that correlate 
to the functional groups covered by the exam. Each chapter is divided into sections 
addressing groups of related skills that correlate to the exam objectives. Each section 
includes review information, generic procedures, and practice tasks you can complete 
on your own while studying. We provide practice files you can use to work through 
the practice tasks, and results files you can use to check your work. You can practice 
the generic procedures in this book by using the practice files supplied or by using 
your own files. (If you use your own files, keep in mind that functionality in Word 2016 
is limited in files created in or saved for earlier versions of the program. When you are 
working in such a file, Compatibility Mode appears in the program window title bar.)

Throughout this book, you will find Exam Strategy tips that present information about 
the scope of study that is necessary to ensure that you achieve mastery of a skill set 
and are successful in your certification effort.

Download the practice files
Before you can complete the practice tasks in this book, you need to copy the book’s 
practice files and results files to your computer. Download the compressed (zipped) 
folder from the following page, and extract the files from it to a folder (such as your 
Documents folder) on your computer:

https://aka.ms/MOSWord2016/downloads

IMPORTANT The Word 2016 program is not available from this website. You should purchase 
and install that program before using this book.

You will save the completed versions of practice files that you modify while working 
through the practice tasks in this book. If you later want to repeat the practice tasks, 
you can download the original practice files again.

https://www.aka.ms/MOSWord2016/downloads
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The following table lists the practice files provided for this book.

Folder and objective group Practice files Result files

MOSWord2016\Objective1
Create and manage documents

Word_1-1a.dotx
Word_1-1b.txt
Word_1-1c.pdf
Word_1-2.docx
Word_1-3.docx
Word_1-4.docx
Word_1-5.docx

Word_1-1_results subfolder:
 ■ MyBlankDoc_results.docx
 ■ MyFaxCover_results.docx
 ■ MyNurseryRhymes 

_results.docx
 ■ MyPDF_results.docx
 ■ MySummerDoc_results.docx

Word_1-2_results.docx
Word_1-3_results.docx
Word_1-4_results.docx
Word_1-5_results subfolder:

 ■ MyBookmarks_results.pdf
 ■ MyCompatible_results.doc

MOSWord2016\Objective2
Format text, paragraphs, and 
sections

Word_2-1a.docx 
Word_2-1b.pptx
Word_2-1c.docx
Word_2-2.docx
Word_2-3.docx

Word_2-1_results.docx
Word_2-2_results.docx
Word_2-3_results.docx

MOSWord2016\Objective3
Create tables and lists

Word_3-1.docx
Word_3-2.docx
Word_3-3.docx

Word_3-1_results.docx
Word_3-2_results.docx
Word_3-3_results.docx

MOSWord2016\Objective4
Create and manage references

Word_4-1.docx
Word_4-2a.docx
Word_4-2b.docx

Word_4-1_results.docx
Word_4-2a_results.docx
Word_4-2b_results.docx

MOSWord2016\Objective5
Insert and format graphic elements

Word_5-1a.docx
Word_5-1b.jpg
Word_5-2.docx
Word_5-3.docx

Word_5-1_results.docx
Word_5-2_results.docx
Word_5-3_results.docx
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Adapt procedure steps
This book contains many images of user interface elements that you’ll work 
with while performing tasks in Word on a Windows computer. Depending 
on your screen resolution or app window width, the Word ribbon on your 
screen might look different from that shown in this book. (If you turn on 
Touch mode, the ribbon displays significantly fewer commands than in Mouse 
mode.) As a result, procedural instructions that involve the ribbon might 
require a little adaptation.

Simple procedural instructions use this format:

 ➜ On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list, our instructions use this format:

 ➜ On the Home tab, in the Editing group, click the Find arrow and then, 
in the Find list, click Go To.

If differences between your display settings and ours cause a button to 
appear differently on your screen than it does in this book, you can easily 
adapt the steps to locate the command. First click the specified tab, and then 
locate the specified group. If a group has been collapsed into a group list 
or under a group button, click the list or button to display the group’s com-
mands. If you can’t immediately identify the button you want, point to likely 
candidates to display their names in ScreenTips.
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Multistep procedural instructions use this format:

1. To select the paragraph that you want to format in columns, triple-click 
the paragraph.

2. On the Layout tab, in the Page Setup group, click the Columns button 
to display a menu of column layout options.

3. On the Columns menu, click Three.

On subsequent instances of instructions that require you to follow the same 
process, the instructions might be simplified in this format because the work-
ing location has already been established:

1. Select the paragraph that you want to format in columns.

2. On the Columns menu, click Three.

The instructions in this book assume that you’re interacting with on-screen 
elements on your computer by clicking (with a mouse, touchpad, or other 
hardware device). If you’re using a different method—for example, if your 
computer has a touchscreen interface and you’re tapping the screen (with 
your finger or a stylus)—substitute the applicable tapping action when you 
interact with a user interface element.

Instructions in this book refer to user interface elements that you click or 
tap on the screen as buttons, and to physical buttons that you press on a 
keyboard as keys, to conform to the standard terminology used in documen-
tation for these products.
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Ebook edition
If you’re reading the ebook edition of this book, you can do the following:

 ■ Search the full text

 ■ Print

 ■ Copy and paste

You can purchase and download the ebook edition from the Microsoft Press Store at:

https://aka.ms/MOSWord2016/detail

Errata, updates, & book support
We’ve made every effort to ensure the accuracy of this book and its companion 
content. If you discover an error, please submit it to us through the link at:

https://aka.ms/MOSWord2016/errata

If you need to contact the Microsoft Press Book Support team, please send an email 
message to:

mspinput@microsoft.com

For help with Microsoft software and hardware, go to:

https://support.microsoft.com

https://www.aka.ms/MOSWord2016/detail
https://www.aka.ms/MOSWord2016/errata
https://www.support.microsoft.com
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We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most 
valuable asset. Please tell us what you think of this book by completing the survey at: 

https://aka.ms/tellpress

The survey is short, and we read every one of your comments and ideas. Thanks in 
advance for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at:

https://twitter.com/MicrosoftPress

https://www.aka.ms/tellpress
https://www.twitter.com/MicrosoftPress
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Taking a Microsoft Office Specialist exam

Desktop computing proficiency is increasingly important in today’s business world. 
When screening, hiring, and training employees, employers can feel reassured by 
relying on the objectivity and consistency of technology certification to ensure the 
competence of their workforce. As an employee or job seeker, you can use technol-
ogy certification to prove that you already have the skills you need to succeed, saving 
current and future employers the time and expense of training you.

Microsoft Office Specialist certification
Microsoft Office Specialist certification is designed to assist students and information 
workers in validating their skills with Office programs. The following certification paths 
are available:

 ■ A Microsoft Office Specialist (MOS) is an individual who has demonstrated 
proficiency by passing a certification exam in one or more Office programs, 
including Microsoft Word, Excel, PowerPoint, Outlook, or Access.

 ■ A Microsoft Office Specialist Expert (MOS Expert) is an individual who has 
taken his or her knowledge of Office to the next level and has demonstrated by 
passing two certification exams that he or she has mastered the more advanced 
features of Word or Excel.

 ■ A Microsoft Office Specialist Master (MOS Master) is an individual who has 
demonstrated a broader knowledge of Office skills by passing the Word and 
Word Expert exams, the Excel and Excel Expert exams, and the PowerPoint, 
Access, or Outlook exam.

Selecting a certification path
When deciding which certifications you would like to pursue, assess the following:

 ■ The program and program version(s) with which you are familiar

 ■ The length of time you have used the program and how frequently you use it
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 ■ Whether you have had formal or informal training in the use of that program

 ■ Whether you use most or all of the available program features

 ■ Whether you are considered a go-to resource by business associates, friends, 
and family members who have difficulty with the program

Candidates for MOS Expert and MOS Master certification are expected to successfully 
complete a wide range of standard business tasks. Successful candidates generally 
have six or more months of experience with the specific Office program, including 
either formal, instructor-led training or self-study using MOS-approved books, guides, 
or interactive computer-based materials.

Candidates for MOS Expert and MOS Master certification are expected to successfully 
complete more complex tasks that involve using the advanced functionality of the 
program. Successful candidates generally have at least six months, and might have 
several years, of experience with the programs, including formal, instructor-led train-
ing or self-study using MOS-approved materials.

Test-taking tips
Every MOS certification exam is developed from a set of exam skill standards (referred 
to as the objective domain) that are derived from studies of how the Office programs 
are used in the workplace. Because these skill standards dictate the scope of each 
exam, they provide critical information about how to prepare for certification. This 
book follows the structure of the published exam objectives. 

See Also For more information about the book structure, see “How this book is organized” in 
the Introduction.

The MOS certification exams are performance based and require you to complete 
business-related tasks in the program for which you are seeking certification. For 
example, you might be presented with a document and told to insert and format 
additional document elements. Your score on the exam reflects how many of the 
requested tasks you complete within the allotted time.
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Here is some helpful information about taking the exam:

 ■ Keep track of the time. Your exam time does not officially begin until after you 
finish reading the instructions provided at the beginning of the exam. During 
the exam, the amount of time remaining is shown in the exam instruction 
window. You can’t pause the exam after you start it.

 ■ Pace yourself. At the beginning of the exam, you will receive information about 
the tasks that are included in the exam. During the exam, the number of com-
pleted and remaining tasks is shown in the exam instruction window.

 ■ Read the exam instructions carefully before beginning. Follow all the instructions 
provided completely and accurately.

 ■ If you have difficulty performing a task, you can restart it without affecting the 
result of any completed tasks, or you can skip the task and come back to it after 
you finish the other tasks on the exam.

 ■ Enter requested information as it appears in the instructions, but without 
duplicating the formatting unless you are specifically instructed to do so. For 
example, the text and values you are asked to enter might appear in the instruc-
tions in bold and underlined text, but you should enter the information without 
applying these formats.

 ■ Close all dialog boxes before proceeding to the next exam item unless you are 
specifically instructed not to do so.

 ■ Don’t close task panes before proceeding to the next exam item unless you are 
specifically instructed to do so.

 ■ If you are asked to print a document, worksheet, chart, report, or slide, perform 
the task, but be aware that nothing will actually be printed.

 ■ Don’t worry about extra keystrokes or mouse clicks. Your work is scored based 
on its result, not on the method you use to achieve that result (unless a specific 
method is indicated in the instructions).

 ■ If a computer problem occurs during the exam (for example, if the exam does 
not respond or the mouse no longer functions) or if a power outage occurs, 
contact a testing center administrator immediately. The administrator will 
restart the computer and return the exam to the point where the interruption 
occurred, with your score intact.
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Exam Strategy This book includes special tips for effectively studying for the Microsoft Office 
Specialist exams in Exam Strategy paragraphs such as this one.

Certification benefits
At the conclusion of the exam, you will receive a score report, indicating whether you 
passed the exam. If your score meets or exceeds the passing standard (the minimum 
required score), you will be contacted by email by the Microsoft Certification Program 
team. The email message you receive will include your Microsoft Certification ID 
and links to online resources, including the Microsoft Certified Professional site. On 
this site, you can download or order a printed certificate, create a virtual business 
card, order an ID card, review and share your certification transcript, access the Logo 
Builder, and access other useful and interesting resources, including special offers from 
Microsoft and affiliated companies.

Depending on the level of certification you achieve, you will qualify to display one of 
three logos on your business card and other personal promotional materials. These 
logos attest to the fact that you are proficient in the applications or cross-application 
skills necessary to achieve the certification. Using the Logo Builder, you can create a 
personalized certification logo that includes the MOS logo and the specific programs 
in which you have achieved certification. If you achieve MOS certification in multiple 
programs, you can include multiple certifications in one logo.

For more information
To learn more about the Microsoft Office Specialist exams and related courseware, 
visit:

http://www.certiport.com/mos

http://www.certiport.com/mos
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Microsoft Office Specialist

Exam 77-725

Microsoft  
Word 2016
This book covers the skills you need to have for certification as a  
Microsoft Office Specialist in Word 2016. Specifically, you need to be  
able to complete tasks that demonstrate the following skill sets:

1 Create and manage documents
2 Format text, paragraphs, and sections
3 Create tables and lists
4 Create and manage references
5 Insert and format graphic elements

With these skills, you can create, populate, format the content of, and manage 
the types of documents most commonly used in a business environment.
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Exam 77-725: Microsoft Word 2016 

Prerequisites
We assume that you have been working with Word 2016 for at least six months and 
that you know how to carry out fundamental tasks that are not specifically mentioned 
in the objectives for this Microsoft Office Specialist exam. Before you begin studying 
for this exam, you might want to make sure you are familiar with the information in 
this section.

Move around in a document
You can view various parts of the active document by using the vertical and horizontal 
scroll bars. Using the scroll bars does not move the cursor—it changes only the part of 
the document displayed in the window. For example, if you drag the vertical scroll box 
down to the bottom of the scroll bar, the end of the document comes into view, but 
the cursor stays in its original location.

Here are some other ways to use the scroll bars:

 ■ Click the up or down scroll arrow on the vertical scroll bar to move the docu-
ment window up or down one line of text.

 ■ Click above or below the scroll box to move up or down one screen.

 ■ Click the left or right scroll arrow on the horizontal scroll bar to move the docu-
ment window to the left or right several characters at a time.

 ■ Click to the left or right of the scroll box to move left or right one screen.

You can also move around in a document by moving the cursor. You can click to place 
the cursor at a particular location, or you can press a key or a key combination to 
move the cursor.
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The following table shows the keys and key combinations you can use to move the 
cursor.

Pressing this key or key combination Moves the cursor

Left Arrow Left one character at a time

Right Arrow Right one character at a time

Down Arrow Down one line at a time

Up Arrow Up one line at a time

Ctrl+Left Arrow Left one word at a time

Ctrl+Right Arrow Right one word at a time

Home To the beginning of the current line

End To the end of the current line

Ctrl+Home To the beginning of the document

Ctrl+End To the end of the document

Ctrl+Page Up To the beginning of the previous page

Ctrl+Page Down To the beginning of the next page

Page Up Up one screen

Page Down Down one screen
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Select text
Before you can edit or format text, you need to select it. You can select any amount of text 
by dragging through it. You can select specific units of text as follows:

 ■ To select a word, double-click it. The word and the space following it are 
selected. Punctuation following a word is not selected.

 ■ To select a sentence, click anywhere in the sentence while holding down the Ctrl 
key. The first character in the sentence through the space following the ending 
punctuation mark are selected.

 ■ To select a paragraph, triple-click it. The paragraph and paragraph mark are 
selected.

You can select adjacent words, lines, or paragraphs by positioning the cursor at the 
beginning of the text you want to select, holding down the Shift key, and then pressing 
an arrow key or clicking at the end of the text that you want to select.

To select non-adjacent blocks of text, select the first block, hold down the Ctrl key, and 
then select the next block.

To select a block of text quickly, you can use the selection area—the empty area to 
the left of the document’s text column. When the pointer is in the selection area, it 
changes from an I-beam to a right-pointing arrow. From the selection area, you can 
select specific units of text as follows:

 ■ To select a line, click in the selection area to the left of the line.

 ■ To select a paragraph, double-click in the selection area to the left of the 
paragraph.

 ■ To select an entire document, triple-click anywhere in the selection area.

To deselect text, click anywhere in the document window other than the selection area.
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Cut, copy, and paste content
Word offers several methods of cutting and copying content. After selecting the 
content, you can click buttons on the ribbon, use a keyboard shortcut, or right-click 
the selection and click commands on the shortcut menu. Cutting or copying content 
places it on the Microsoft Office Clipboard. You can paste content that is stored on the 
Clipboard into a document (or any Office file) by using commands from the ribbon, 
shortcut menu, or keyboard, or directly from the Clipboard. 

Experienced users might find it fastest to use a keyboard shortcut. The main keyboard 
shortcuts for editing tasks are shown in the following table.

Task Keyboard shortcut

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Undo Ctrl+Z

Repeat/Redo Ctrl+Y

Exam Strategy When you paste content into a Word document, the Paste Options menu 
presents options for formatting the pasted content. Exam 77-725 does not include items that 
test your knowledge of the Paste Options menu.

You can move or copy text by dragging it within the same document. To copy the 
selection instead of moving it, hold down the Ctrl key while you drag. The dragged 
text is not stored on the Clipboard, but the Paste Options list is available when you 
release the mouse button so that you can adjust the formatting of the moved or 
copied content.

See Also For information about managing the Clipboard and pasting content in alternative 
formats, see “Objective 2.1: Insert text and paragraphs.”
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Access program commands and options
Commands for working with Word documents (rather than document content) are 
available from the Backstage view. You display the Backstage view by clicking the File 
tab on the ribbon.

The Backstage view of a document displays information about the current document, 

The links in the left pane of the Backstage view provide access to 11 pages that contain 
information about the current document, commands for working with the document, 
or commands for working with Word. To display the Info, New, Open, Save As, History, 
Print, Share, Export, Account, Options, or Feedback page, click the page name in the 
left pane.
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Exam overview

You manage many aspects of Word functionality from the Word Options dialog box, 
which you open by clicking Options in the left pane of the Backstage view.

The Word Options dialog box

The Word Options dialog box has 10 separate pages of commands, organized by func-
tion. To display the General, Display, Proofing, Save, Language, Advanced, Customize 
Ribbon, Customize Quick Access Toolbar, Add-ins, or Trust Center page of the Word 
Options dialog box, click the page name in the left pane.



This page intentionally left blank 



3

109

Objective group 3

Create tables and lists
The skills tested in this section of the Microsoft Office Specialist exam for 
Microsoft Word 2016 relate to creating and modifying tables and lists. 
Specifically, the following objectives are associated with this set of skills:

3.1 Create tables
3.2 Modify tables
3.3 Create and modify lists

Some types of document content are easier to read when presented in a struc-
tured format; specifically, in a table or list. Tables are particularly useful for 
presenting numeric data, but also for organizing text. Numbered lists are an 
effective means of presenting information that has a specific order or for which 
you want to designate labels. Bulleted lists present unordered sets of information 
in a tidy format that is far more legible than running the information together in a 
long paragraph.

This chapter guides you in studying ways of creating, modifying, and formatting 
tables, bulleted lists, and numbered lists; and sorting table data.

To complete the practice tasks in this chapter, you need the practice files  
contained in the MOSWord2016\Objective3 practice file folder. For more  
information, see “Download the practice files” in this book’s introduction.
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Objective 3.1: Create tables
Data sets, particularly of numeric data, can often be presented more clearly and 
efficiently in a table than in a paragraph of text. Tables present large amounts of data, 
or complex data, in a format that is easier to read and understand by structuring it in 
rows and columns, which often include headers to explain the purpose or meaning of 
the data.

Tip When designing a table to meet accessibility standards, include row headers. For informa-
tion about Word document accessibility, see “Objective 1.5: Print and save documents.”

You can create a table structure and then enter information in the table cells, you can 
convert existing text into a table, or you can copy and paste a table structure from 
another Microsoft Office file, such as an Excel worksheet, a PowerPoint slide, or an 
Access data table.

There are two simple methods for creating blank tables:

 ■ The Insert Table menu displays a grid in which you select a range of cells—up 
to 10 columns wide and 8 rows high—to create a table of that size. When you 
create a table this way, each row is one line high and all the columns are of 
equal width.

 ■ The Insert Table dialog box provides an interface in which you enter or select 
the number of rows and columns you want to create, and you can specify a 
fixed or relative column width.

Exam Strategy Exam 77-725 tracks the results you achieve, rather than the method you use 
to perform each task. In addition to the methods discussed in this topic, you can use the Draw 
Table feature to manually define table rows and columns on the document page; however, this 
isn’t a very efficient method of creating a table, and you will not be required to demonstrate it 
on the exam.
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You can select AutoFit options when creating a table or any time thereafter

A table appears in the document as a set of cells, usually delineated by borders or 
gridlines. Each cell contains an end-of-cell marker, and each row ends with an end-of-
row marker. These markers are visible only when hidden formatting marks are shown.

Tip Two separate elements in Word 2016 are named gridlines, and both can be used in 
association with tables. From the Show group on the View tab, you can display the document 
gridlines with which you can position content on the page. From the Table group on the 
Layout tool tab, you can display the table gridlines that define the cells of a table.

When you point to a table, a move handle appears in its upper-left corner and a size 
handle in its lower-right corner. When the cursor is in a table, two Table Tools tabs—
Design and Layout—appear on the ribbon.
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End-of-cell and end-of-row markers are visible only when formatting marks are displayed

Tip End-of-cell markers and end-of-row markers are identical in appearance, and are visible 
only when you display formatting marks in the document.

Create tables from scratch or from text
Converting text to a table is particularly easy when the text has a consistent structure, 
such as that of a tabbed list. You can convert cell entries that are separated by tabs, 
commas, paragraph marks, or another single character. Similarly, you can convert any 
table to text that is separated by the same selection of characters.

Consistent text separation is key when converting between text and tables
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When converting a table to text, the text separator that you choose affects the text layout.

The effects of the standard text separator options

To create a blank page-width table with columns of equal width

1. On the Insert tab, in the Tables group, click the Table button.

2. In the grid, move the pointer across and down to select the number of columns 
and rows you want, and then click the lower-right cell in the selection.

To create a table and specify column fitting options

1. On the Insert tab, in the Tables group, click the Table button, and then click 
Insert Table.

2. In the Insert Table dialog box, in the Table size area, specify the number of 
columns and rows you want the table to include.

3. In the AutoFit behavior area, do one of the following, and then click OK:

 ● To specify the width of the table columns, click Fixed column width, and 
then enter the width in the box.

 ● To size the table columns to fit their contents, click AutoFit to contents. The 
width of the resulting table may be less than the width of the page.

 ● To create a page-width table that is divided into columns of equal width, 
click AutoFit to window.
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See Also After creating a table, it is common to change the size of one or more columns to fit 
your needs. For information about resizing columns, see “Objective 3.2: Modify tables.”

To convert text to a table

1. Ensure that the text you want to convert uses a consistent method of separating 
the content that will go into the table cells.

2. Select the text that you want to convert.

3. On the Insert tab, in the Tables group, click the Table button, and then click 
Convert Text to Table.

4. In the Convert Text to Table dialog box, in the Separate text at section, click or 
enter the cell text separator. Word evaluates the selected text and indicates the 
number of rows and columns that will fit it. 

5. In the Table size section, review the Number of columns entry against the 
selected content and adjust it as necessary.

Tip If the Number Of Columns or Number Of Rows setting doesn’t seem correct, the 
selected text might not use consistent text separators.

6. Adjust the Table size and AutoFit behavior settings, select the type of text 
separator, and then click OK.

To convert a table to text

1. Select or click anywhere in the table.

2. On the Layout tool tab, in the Data group, click Convert to Text.

3. In the Convert Table To Text dialog box, click the text separator you want to use, 
and then click OK:

 ● To put each cell entry in its own paragraph, click Paragraph marks.
 ● To put the cell entries from each row into one paragraph, do any of the 

following:
 ۵ To create a tabbed list with the same number of columns as the table, 

click Tabs.
 ۵ To put a comma and space between cell entries, click Commas.
 ۵ To put any single character between cell entries, click Other and enter 

the character in the Other box. 
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Apply table styles
To quickly and professionally format a table, you can apply one of the built-in table 
styles. These include a variety of borders, shading choices, text colors, and other attri-
butes to give the table a professional look. When formatting a table, you can choose 
the table elements that you want to emphasize, such as a header or total row or the 
first or last column, and you can format the table with banded columns or rows to 
make the contents more legible.

Tip When table cells aren’t defined by borders or other formatting, you can display non- 
printing gridlines to more easily identify individual cells.

Built-in table style colors are controlled by the theme colors

To apply a built-in table style

1. Click anywhere in the table you want to format.

2. On the Design tool tab, in the Table Styles gallery, click the built-in style you 
want to apply.
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To emphasize table elements

 ➜ On the Design tool tab, in the Table Style Options group, select the check boxes 
of the table elements you want to emphasize.

To manually format table elements

 ➜ To shade cells, columns, or rows, select the element and then on the Design tool  
tab, in the Table Styles group, click the Shading arrow and select the color you want.

 ➜ To change the color or width of borders, on the Design tool tab, in the Borders 
group, select the border style, line style, line weight, and pen color you want, 
and then do either of the following:

 ● On the Borders menu, click the border configuration that you want to insert 
with the selected settings.

 ● Click the Border Painter button, and then click individual table borders to 
apply the selected settings.

 ➜ To remove selected cell borders, do either of the following:

 ● Select one or more cells, rows, or columns from which you want to remove 
the borders. Then on the Design tool tab, in the Borders group, on the 
Borders menu, click No Border.

 ● On the Layout tool tab, in the Draw group, click the Eraser button, and then 
click individual table borders to remove them. Click the Eraser button again, 
press Esc, or click away from the table to turn off the feature.

To display or hide table gridlines

 ➜ On the Layout tool tab, in the Table group, click the View Gridlines button.

To format text in tables

 ➜ Select the text and format it as you would regular text, by clicking buttons on 
the Mini Toolbar and in the Font, Paragraph, and Quick Styles groups on the 
Home tab.
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Objective 3.1 practice tasks
The practice file for these tasks is located in the MOSWord2016\Objective3 
practice file folder. The folder also contains a result file that you can use to check 
your work.

 ➤ Open the Word_3-1 document, and do the following:

 ❑ In the Consultation Request section, convert the paragraphs that follow 
the heading into a page-width table with five equal-width columns.

 ❑ In the Mileage section, convert the tabbed list into a table that has two 
columns and six rows. Ensure that each column exactly fits its contents.

 ❑ Apply the Grid Table 4 – Accent 1 built-in table style to the table. 
Configure the table style options to emphasize the header row and to 
have banded columns. (Clear all other check boxes.) 

 ❑ In the Consultation section, convert the table to a tabbed list.

 ❑ In the blank paragraph below the Estimate heading, insert an empty 
table that is three columns wide and four rows high, with each column 
exactly 1.5” wide.

 ❑ Apply the List Table 5 Dark – Accent 1 built-in table style to the table,  
with the default table style options.

 ➤ Save the Word_3-1 document.

 ➤ Open the Word_3-1_results document. Check your work by comparing the 
open documents.

 ➤ Close the open documents.
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Objective 3.2: Modify tables

Sort table data
You can sort the data within a table by the contents of one or more table columns. 
Word sorts only the data rows in your table, and not the header row or Total row (if 
your table includes either of these options).

You can sort the data in a table by multiple columns

To activate a table for editing

 ➜ Select or click anywhere in the table.

To sort table data

1. Activate the table for editing.

2. On the Layout tool tab, in the Data group, click the Sort button. The Sort dialog 
box opens, with the table’s column headers available in the Sort By and Then 
By lists. If headers aren’t configured in the table style options, the list entries are 
(Column 1), (Column 2), and so on.

3. If your table includes headers and the Sort function didn’t identify them as such, 
click Header row in the My list has section near the bottom of the dialog box to 
add the headers to the Sort By and Then By lists.
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4. In the Sort by section, select the primary column by which you want to sort 
the content. Verify that the Sort function has correctly identified the Type and 
Using settings, and then click Ascending or Descending to specify the sort 
order.

5. If you want to perform a nested sort on additional criteria, repeat step 4 in one 
or both of the Then by sections.

6. In the Sort dialog box, click OK.

Exam Strategy Create a table that contains multiple columns and many rows of data and 
observe the effect of sorting the table by various columns, with and without a header row, to 
understand the sorting process.

Modify table structure
You can modify a table’s structure at any time. The basic ways to do so are as follows:

 ■ Insert or delete rows or columns.

 ■ Change the height or width of the table, columns, or rows.

 ■ Modify the alignment and spacing within cells.

 ■ Merge multiple cells into one cell or split one cell into multiple cells.

Inserting a column within an existing table structure

This topic reviews methods you can use to accomplish these tasks.
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Tip You can move a table by pointing to it and then dragging the move handle that appears 
in the table’s upper-left corner. Or you can click the move handle to select the table, and then 
use the Cut and Paste commands.

Insert and delete rows and columns
As you develop your table content, you might need to add or remove rows or columns.

To insert a row or column 

 ➜ Point to the left edge of the table, between two rows where you want to insert 
another, or to the top of the table between two columns where you want to 
insert another. A gray insertion indicator labeled with a plus sign appears as you 
approach a possible insertion point (after any existing row or column). When 
the plus sign turns blue, click to insert the row or column where indicated.

 ➜ To insert a row at the end of a table, click in the last cell of the last row, and then 
press Tab to create a new row with the same formatting as the previous row.

Or

1. Position the cursor in a cell adjacent to which you want to insert a row or column.

2. On the Layout tool tab, in the Rows & Columns group, do either of the following:

 ● To insert a row, click Insert Above or Insert Below.

 ● To insert a column, click Insert Left or Insert Right.

Exam Strategy The Insert commands are available on the Mini Toolbar that appears when you 
select table content; however, that feature might be unavailable in the exam environment.

To insert multiple rows or columns

1. Select the number of existing rows or columns that you want to insert in the 
table, adjacent to the location you want to insert them.

2. On the Layout tool tab, in the Rows & Columns group, do either of the 
following:

 ● To insert the selected number of rows, click Insert Above or Insert Below.

 ● To insert the selected number of columns, click Insert Left or Insert Right.
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To delete a table, rows, or columns

1. Click anywhere in the table, row, or column you want to delete, or select the 
rows or columns you want to delete.

2. On the Layout tool tab, in the Rows & Columns group, on the Delete menu, 
click Delete Rows, Delete Columns, or Delete Table.

Resize tables, rows, and columns
Some tables are the width of the page and others are narrower to fit their contents 
without leaving a lot of white space. You can change the dimensions of a table by 
changing the width of the columns or the height of the rows; you can also change the 
dimensions of the columns and rows by changing the width of the table.

Table, row, and column size can be set in the document, on the ruler, or in the Table 
Properties dialog box. When working in the document, use the controls located in the 
Cell Size group on the Layout tool tab.

Some of the many tools for adjusting the row height and column width
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When you display the ruler and activate a table, markers on the ruler indicate the 
table column and row dividers and the margin indents of the active column.

Activate any cell to display its dividers and indent markers on the rulers

See Also For information about the different types of indent markers, see “Objective 2.2: 
Format text and paragraphs.”

To open the Table Properties dialog box

 ➜ Right-click anywhere in the table, and then click Table Properties.
Or

1. Click anywhere in the table or select any table element.

2. On the Layout tool tab, in the Table group, click the Properties button.

Table and column width can be set by percentage of the available space or in inches
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To modify table structure from the Table Properties dialog box

 ➜ On the Table tab, set the table width in inches or percentage of the page width.

 ➜ On the Row tab, set the height of the selected rows.

 ➜ On the Column tab, set the preferred width of the selected column or columns.

 ➜ On the Cell tab, set the width of selected cells.

To select table elements

 ➜ Click anywhere in the table, column, row, or cell you want to select. On the 
Layout tool tab, in the Table group, on the Select menu, click Select Cell, Select 
Column, Select Row, or Select Table.

 ➜ To select a table, point to the table, and then click the move handle that appears 
outside its upper-left corner.

 ➜ To select a row, point to the left border of the row. When the pointer changes to 
a white, right-pointing arrow, click once.

 ➜ To select a column, point to the top border of the column. When the pointer 
changes to a black, down-pointing arrow, click once.

 ➜ To select a cell, triple-click the cell or click its left border.

 ➜ To select adjacent rows, columns, or cells, do either of the following:

 ● Select the first row, column, or cell, hold down the Shift key, and then press 
the arrow keys.

 ● Drag across the rows, columns, or cells that you want to select.

 ➜ To select non-adjacent rows, columns, or cells, select the first, hold down the 
Ctrl key, and then select the others.

To change the size of a selected table

 ➜ Drag the size handle in the lower-right corner of the table. If you want to 
maintain the original aspect ratio of the table, hold down the Shift key while 
dragging the size handle.

 ➜ On the Table tab of the Table Properties dialog box, specify the table width in 
inches or percentage of the available page width, and then click OK.

Tip This book specifies measurements in inches. You can alternatively use your regional 
unit of measurement.
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To change the height of a selected row

 ➜ Drag the row’s bottom border up or down.

 ➜ Drag the row’s Adjust Table Row marker on the vertical ruler up or down.

 ➜ On the Layout tool tab, in the Cell Size group, change the Table Row Height 
setting.

 ➜ On the Row tab of the Table Properties dialog box, specify the exact or minimum 
row height, and then click OK.

Tip Setting a minimum row height enables the row height to increase when the height 
of cell content exceeds that measurement. You can set the row height in units such as 
pixels (px), but Word converts the measurement to inches when you save the changes.

 ➜ With multiple rows selected, click the Distribute Rows button in the Cell 
Size group on the Layout tool tab, or right-click the selection and then click 
Distribute Rows Evenly.

To change the width of a selected column

 ➜ Double-click the column’s right border to set it to the narrowest width that fits 
its content.

 ➜ Drag the column’s right border to the left or right.

 ➜ Drag the column’s Move Table Column marker on the horizontal ruler to the 
left or right.

 ➜ On the Layout tool tab, in the Cell Size group, change the Table Column Width 
setting.

 ➜ On the Column tab of the Table Properties dialog box, specify the column 
width in inches or percentage of the table width, and then click OK.
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To change the width of multiple columns

 ➜ To equalize the width of contiguous columns, select the columns, and then do 
either of the following:

 ● On the Layout tool tab, in the Cell Size group, click the Distribute Columns 
button.

 ● Right-click the selection, and then click Distribute Columns Evenly.

 ➜ To relatively size all columns into a page-width table, activate the table, and 
then on the Layout tool tab, in the Cell Size group, click AutoFit and then 
AutoFit Window.

 ➜ To fit all columns in a table to their contents, select or click anywhere in the 
table, and then on the Layout tool tab, in the Cell Size group, click AutoFit and 
then AutoFit Contents.

Configure cell alignment and spacing
You can specify the alignment of content within table cells not only horizontally—
Left, Center, and Right—but also vertically—Top, Center, and Bottom. There are nine 
alignment combinations in all, available from the Design tool tab. They are visually 
identified in the Alignment group on the Layout tool tab.

The alignment buttons are arranged and labeled to be easily identifiable

Tip Many programs refer to the vertical alignment positions as Top, Middle, and Bottom. 
Word 2016 labels both the horizontal and vertical center-alignment positions as Center.

Each cell within a table has internal margins that define the amount of space within 
the cell that content can occupy. By default, cells have only left and right margins. 
You can also specify top and bottom margins if you want to ensure that content has a 
minimum amount of padding for readability. 
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Cell margins and cell spacing affect the entire table

Tip Cell margins affect the space available within the cell for content. Cell spacing makes the 
surrounding cells smaller.

To configure internal and external table cell spacing

1. Activate the table.

2. On the Layout tool tab, in the Alignment group, click the Cell Margins button 
to open the Table Options dialog box.

3. In the Table Options dialog box, do any of the following, and then click OK.

 ● In the Default cell margins section, enter or select the amount of space you 
want Word to leave clear of content inside of each cell.

 ● In the Default cell spacing section, if you want to insert blank space 
between cells, select the Allow spacing between cells check box and then 
enter the cell spacing in the box.

 ● In the Options section, if you want to prevent the cell size from changing 
with the content, clear the Automatically resize to fit contents check box.
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Merge and split cells
There are many circumstances in which you might want to merge the contents of two 
cells, either horizontally or vertically, or split one cell into multiple cells. Each of these 
operations changes the table from a simple grid to a more complex structure. 

IMPORTANT Some operations (adding or removing columns or rows) aren’t possible when 
part of a table has merged cells. If you need to modify a table and the operation you want to 
perform is restricted, revert the split or merged cells to their original form, perform the opera-
tion, and then repeat the split or merge process.

To create cells that span multiple rows or columns

 ➜ Select the adjacent cells you want to connect. Then on the Layout tool tab, in 
the Merge group, click the Merge Cells button.

To divide a selected cell into multiple cells

1. On the Layout tool tab, in the Merge group, click the Split Cells button.

One cell can be split into up to 63 columns and 30 rows

2. In the Split Cells dialog box, specify the number of columns and rows into 
which you want to divide the cell, and then click OK.

Manage long tables
A table can run across multiple pages. When it does (or if it might), you can configure 
the table to display a copy of the header row at the top of each subsequent page. 
You can’t select or modify the dynamic header row; any changes must be made in the 
actual table header. Repeating the header row helps readers of a document to more 
easily interpret data in multipage tables. It also allows assistive devices such as screen 
readers to correctly interpret the table contents. 
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In some cases, you might find that you want to manually split a large table into two or 
more tables, perhaps to move part of the data to another location in the document.

To repeat the table header row on subsequent pages

1. Position the cursor in the table header row.

2. Do either of the following:

 ● On the Layout tool tab, in the Data group, click the Repeat Header Rows 
button.

 ● Open the Table Properties dialog box, display the Row tab, select the 
Repeat as header row at the top of each page check box, and then click OK.

IMPORTANT The Repeat Header Rows button and Repeat As Header Row option are 
active only when the cursor is in the header row.

To split a table

1. Position the cursor anywhere in the row that you want to be the first row of the 
new table that Word creates when you split the original table.

2. On the Layout tool tab, in the Merge group, click the Split Table button.

The active row becomes the header row of the new table.

Tip If you intend to split the table in more places, do so before resetting the header so you 
can save time by copying the header only once and then pasting it to the new tables.

To duplicate the original table header after splitting a table

1. Select and copy the original table header.

2. Position the cursor in the first cell of the new table, and then paste the copied 
header row.
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Objective 3.2 practice tasks
The practice file for these tasks is located in the MOSWord2016\Objective3 
practice file folder. The folder also contains a result file that you can use to check 
your work.

 ➤ Open the Word_3-2 document, and do the following:

 ❑ In the Customer List section, delete the ID column from the table.

 ❑ Perform a nested sort to sort the table in ascending order by State, then 
by City, and then by Last Name.

 ❑ Delete all rows that contain contacts located in Boston, MA.

 ❑ Add two blank columns to the right side of the table. In the header 
row, enter Date at the top of the first column and Time at the top of the 
second column.

 ❑ Add a blank row to the top of the table. In the table style options, turn 
off the Header Row formatting.

 ❑ In the blank row, merge the cells above the Last Name, First Name, 
Address, City, and State columns into one cell. Enter Customer in the 
merged cell.

 ❑ In the same row, merge the cells above the Date and Time columns. 
Enter Appointment in the merged cell.

 ❑ Select the top two rows of the table. Format the text as bold, and center 
the text horizontally and vertically within the cells.

 ❑ Change the width of the table to 100 Percent of the page width.

 ❑ Select the table rows that contain customer information. Set the height 
of the rows to 0.4” and the cell alignment to Align Center Left.

 ❑ Scroll to page 2 of the document, which now contains several rows of 
the table. Configure the table to repeat the Customer/Appointment 
header row at the top of the second page.

 ➤ Save the Word_3-2 document.

 ➤ Open the Word_3-2_results document. Check your work by comparing 
the open documents. Then close the documents.
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Objective 3.3: Create and modify lists
Lists are paragraphs that start with a character and are formatted with a hanging 
indent so that the characters stand out on the left end of each list item. You can 
format an existing set of paragraphs as a bulleted, numbered, or multilevel list, or 
create the list as you enter information into the document. You can choose list starting 
characters from a library of preselected bullet symbols and numbering patterns, or 
you can create your own.

A list can contain a mix of numbered and bulleted items

After you create a bulleted or numbered list, you can modify the content and format-
ting of the list items, or even change the list type. You can change the bullet symbols, 
numeric characters, and list item levels. When working with numbered lists, you can 
manage the numbering so that the values start or restart as necessary.

Tip List levels are similar to outline levels—a standard list is Level 1, a sublist of a list item is Level 2, 
a sublist of a sublist item is Level 3, and so on. The built-in list formats support nine list levels.

Exam Strategy To pass Exam 77-725 and become certified as a Microsoft Office Specialist in 
Word 2016, you must demonstrate that you can create bulleted and numbered lists, change the 
level of selected list items, manage the starting values of numbered lists, change bullet charac-
ters and define custom bullets, and change number formats and define custom number formats.
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Create and manage bulleted lists
To create a bulleted list

1. Enter the list items as separate paragraphs, and then select the paragraphs.

2. On the Home tab, in the Paragraph group, do either of the following:

 ● To use the standard bullet, click the Bullets button.

 ● To select a bullet, click the Bullets arrow and then, in the Bullet Library, click 
the bullet symbol you want to display before each list item.

The symbols in your Bullet Library include default symbols and those you’ve recently used in lists

Or

1. Enter * (an asterisk) at the beginning of a paragraph, press the Spacebar or the 
Tab key, enter the first list item, and then press Enter.

2. Enter items and press Enter to add subsequent bulleted items.

3. To end the list, do one of the following:

 ● To start the next paragraph at the left margin, press Enter twice.

 ● To indent the next paragraph at the same level as the list, press Enter and 
then press Backspace or click None in the Bullet Library.

Tip If you want to start a paragraph with an asterisk or number but don’t want to format the 
paragraph as a bulleted or numbered list, click the AutoCorrect Options button that appears 
after Word changes the formatting, and then in the list, click the appropriate Undo option. 
You can also click the Undo button on the Quick Access Toolbar.
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To change the bullet symbol of bulleted list items

1. Select the list items you want to change the symbol for, or, to change all items in 
a list, click anywhere in the list.

2. On the Home tab, in the Paragraph group, click the Bullets arrow, and then in 
the Bullet Library, click the symbol you want to use.

To define custom bullets

1. On the Home tab, in the Paragraph group, click the Bullets arrow, and then 
click Define New Bullet.

2. In the Define New Bullet dialog box, do one of the following, and then click OK 
to add the bullet to the Bullet Library.

 ● Click the Symbol button. In the Symbol dialog box, locate and click the 
bullet symbol you want to use, and then click OK.

Choose a symbol from the Symbol font or choose a different font in the Font list
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 ● Click the Picture button. In the Insert Pictures dialog box, locate and click 
the bullet graphic you want to use, and then click OK.

 ● To override the document font, click the Font button, select the font attri-
butes you want in the Font dialog box, and then click OK.

 ● In the Alignment list, click Left, Centered, or Right to specify the bullet 
alignment.

Create and manage numbered lists
To create a numbered list

 ➜ Select the paragraphs you want to include in the list. On the Home tab, in the 
Paragraph group, do one of the following:

 ● Click the Numbering button to apply the standard numbered list format.

 ● Click the Numbering arrow and then click the numbering format you want 
the list to follow.

The standard number formats include a mix of numbers and roman numerals

Or
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1. Enter 1. (the number 1 followed by a period) at the beginning of a paragraph, 
press the Spacebar or the Tab key, enter the first list item, and then press Enter.

2. Enter items and press Enter to add subsequent numbered items.

3. To end the list, do one of the following:

 ● To start the next paragraph at the left margin, press Enter twice.

 ● To indent the next paragraph at the same level as the list, press Enter and 
then press Backspace or click None in the Numbering Library.

Tip The following procedure applies both to bulleted lists and to numbered lists.

To change the level of an active list item

 ➜ Select the list item or items you want to change, and then do any of the 
following:

 ● Press Tab to demote the items or Shift+Tab to promote the items.

 ● On the Home tab, in the Paragraph group, click the Increase Indent button 
to demote the items or the Decrease Indent button to promote the items.

 ● On the Home tab, in the Paragraph group, click the Bullets arrow or the 
Numbers arrow, click Change List Level, and then in the Change List Level 
gallery, click the level you want.

To change the number format of numbered list items

1. Select the list items you want to format, or, to format all items in a list, click 
anywhere in the list.

2. On the Home tab, in the Paragraph group, click the Numbering arrow, and 
then click the number pattern you want to use.

To define a custom number format

1. On the Home tab, in the Paragraph group, click the Numbering arrow, and 
then click Define New Number Format.
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2. In the Define New Number Format dialog box, do any of the following, and 
then click OK to add the number format to the Numbering Library area of the 
Numbering menu:

 ● In the Number style list, click the numbering style you want to use.

Specify the numbering style and any unchanging characters  
you want to display before or after the number

 ● If you want to override the document font, click the Font button, select the 
font attributes you want in the Font dialog box, and then click OK.

 ● In the Number format box, enter any characters (such as a period or the 
word Level) that you want to insert before or after the number.

 ● In the Alignment list, click Left, Centered, or Right to specify the number 
alignment.
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To restart the numbering of a numbered list

 ➜ Right-click the number of the first list item you want to change, and then click 
Restart at 1.

Or

1. Position the cursor in the list item from which you want to restart. (Subsequent 
list items will renumber to follow the value you set.)

2. On the Numbering menu, click Set Numbering Value.

3. In the Set Numbering Value dialog box, click Start new list, and then click OK.

To continue the numbering of a numbered list

 ➜ Right-click the number of the first list item you want to change, and then click 
Continue Numbering.

Or

1. Position the cursor in the first list item you want to change.

2. On the Numbering menu, click Set Numbering Value.

3. In the Set Numbering Value dialog box, click Continue from previous list.

4. If you want to skip over numbered lists that are between the original list and the 
continuation, select the Advance value check box and then, in the Set value to 
box, enter the number you want to assign to the list item.

5. In the Set Numbering Value dialog box, click OK.



137

Objective 3.3: Create and modify lists

3

To set the starting value for all or part of a numbered list

1. Right-click the number of the first list item you want to change, and then click 
Set Numbering Value.

You can specify a list item number at the beginning of or within a list; the following items continue 
from the custom value

2. In the Set Numbering Value dialog box, in the Set value to box, enter or select 
the number you want to assign to the list item. Then click OK.
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Objective 3.3 practice tasks
The practice file for these tasks is located in the MOSWord2016\Objective3 
practice file folder. The folder also contains a result file that you can use to check 
your work.

 ➤ In the Word 3-3 document, do the following:

 ❑ In the Characters of a Hit Fantasy section, format the four paragraphs 
as a bulleted list that uses the standard bullet character ().

 ❑ In the sections titled The Hero and The Teacher, format the paragraphs 
as bulleted lists that uses a custom bullet symbol of your choice from 
the Wingdings font.

 ❑ In the Plot Elements of a Hit Fantasy section, format the three para-
graphs as a bulleted list that uses the four-diamond character ().

 ➤ In the section titled The Sequence of Events, do the following:

 ❑ Format the four paragraphs below the heading as a numbered list that 
uses the A. B. C. number format.

 ❑ Paste a copy of the list into the last blank paragraph of the document, 
and restart the list numbering. Change the number format of the 
second list to the 1) 2) 3) format.

 ❑ Immediately below the second list, paste another copy of the list, and 
change it to a second-level list.

 ❑ Change the second-level list to a bulleted list that uses the square 
bullet character ().

 ➤ Save the Word_3-3 document.

 ➤ Open the Word_3-3_results document. Check your work by comparing 
the open documents.

 ➤ Close the open documents.
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A
accessibility, alternative text 184–185
Accessibility Checker 63–64, 67
alignment

bulleted lists 133
numbered lists 135
objects 181
positions 125–126
table cells 125–126

alternative text, adding to objects 184–185
authors, adding/removing from Author 

property 52
AutoCorrect

adding text shortcuts 74
inserting text strings 73–74

AutoFit, setting options 113–114

B
background elements, removing from 

pictures 178–179
backward compatibility, maintaining 68
bibliographies 

See also citations
creating source placeholders 147
creating sources 147
modifying source placeholders 148
specifying styles for 144–145

bookmarks
creating 24
inserting 25
inserting hyperlinks 23
moving to 25

breaking lines automatically 32
breaks See page breaks; section breaks

built-in styles 87
See also styles

bulleted lists 
See also lists; numbered lists
alignment 133
changing bullet symbols 132
creating 131

bullets
changing symbols 132
custom 132–133

C
captions

configuring 150–152
inserting 150
number formats 149
referencing figures 148

cells, table 
See also tables
alignment 126–127
configuring alignment of 125–126
configuring margins 125
configuring spacing of 125–126
dividing 127
merging 127
splitting 127

character styles 87, 91
citations 146–149 

See also bibliographies
Clipboard 75
clippings, screen 169
column breaks 101

displaying 104
inserting 107
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columns, table

columns, table
See also cells; rows; tables
built-in configurations 106
changing width of 124–125
deleting 121
displaying lines between 107
formatting text as 104, 106
inserting 120
manually breaking content 32
preset configurations 106
resizing 121
reverting to single column 107
and section breaks 105

commands
adding to Quick Access Toolbar 48
in Backstage View 6–7
changing order on Quick Access 

Toolbar 49
for formatting images 175
removing from Quick Access Toolbar 49
separating on Quick Access Toolbars 49

Compatibility Checker 65–68
cover pages

creating 156–157
inserting predefined pages 157–158
removing predefined pages 159

cursor, moving 3
cycle diagrams, creating by using 

SmartArt 186

D
date, inserting in headers/footers 39
diagrams

applying styles to 191
changing color schemes of 191
changing layouts of 192
types 186

Document Inspector 61–63, 66–67

document templates
finding 10
previewing 10

document themes, applying 34–35
document views

changing 44–45
customizing zoom settings 45–46

document templates 10, 87
documents

adding properties 51–52
checking for accessibility 63–64
checking for compatibility 65–67
commands for working with 6–7
correcting compatibility issues 68
creating blank 10–11
creating from templates 10, 12
default template 87
displaying style area pane 91
dividing into sections 32, 99–101
Document Inspector 61–63
formatting in columns 104–106
hyphenating words 33
inserting hyperlinks 23
inserting text from other files 75
inspecting for issues 61–63, 66–68
maintaining backward compatability 68
modifying page setup 29–30
modifying properties 51–52
navigating through 2–3
paragraph spacing 87
printing 56–57
properties 51–52
saving in alternative file formats 57–61
section breaks 99–101
themes 34
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headers

footnotes
converting to endnotes 143
creating 143
number formats 141–142, 144
setting location of 141, 143

Format Painter 83
formatting

clearing 96
copying 83
page backgrounds 41–42
page numbering 40–41
paragraphs 84–87
text 82–83
text into columns 31

formatting breaks, finding 17
formatting marks

displaying/hiding 52, 101, 104
finding 17

G
Go To function, using 26
graphic elements 

See also images; shapes; SmartArt graphics
and cover pages 156
in headers/footers 37

graphics
applying built-in styles to 176
formatting 174–179

gridlines 111, 116

H
header rows, repeating in tables 128
headers 37

activating 38
deleting 39
editing 37
inserting custom 38
inserting date/time in 39

E
endnotes

converting to footnotes 143
creating 143
number formats 141–142, 144
setting location of 141, 143

exam
prerequisites 2–7
tips xvi–xvii

F
figure captions

inserting 150
number formats 149

figures 148
file formats, alternative 57–61
files

inserting hyperlinks 22
saving as PDF or XPS 61
working with previous versons 65–66

Find And Replace 77–78
finding 19

formatting marks and breaks 17
objects 17
and replacing text 78–79
special characters 17
specific characters 20
specific objects 19
specific text 18, 20
using wildcard characters 17, 20

footers 37
activating 38
deleting 39
editing 37
inserting custom 38
inserting date/time in 39
inserting preformatted 38
inserting preformatted page numbers 40
modifying standard settings 39
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headings, inserting hyperlinks to

headers (continued)
inserting preformatted 38
inserting preformatted page numbers 40
modifying standard settings 39

headings, inserting hyperlinks to 23
hidden characters, displaying/hiding 52
hidden formatting marks, displaying/

hiding 52
hierarchy diagrams, creating by using 

SmartArt 186
highlighting, removing 96
hyperlinks

inserting 21–23
modifying 23
removing 23

hyphenation
automatic 32–33
controlling 33
selective 33

I
images

See also graphic elements; shapes; 
SmartArt graphics

adjusting brightness, colors, and contrast 
of 174

applying artistic effects to 175, 177
applying picture frame style to 177–178
applying preformatted styles to 175
applying styles to 175
capturing app windows as 168–169
formatting 174–175
inserting from files 168
inserting from online 168
positioning 179–181
removing background elements 

from 178–179
sources of 167
text wrapping options 179

indents 84

K
keyboard shortcuts

for common symbols 72–73
for editing 5

L
line breaks, automatic 32
line numbers, inserting/controlling 32
line spacing 85
lines, indenting 84–85
linked copies, updating 77
list diagrams, creating by using SmartArt 186
lists 130 

See also bulleted lists; numbered lists
changing bullet symbols 132
changing level of 134
changing number format of 134
creating bulleted 131
creating numbered 133–134
defining custom format 134–135
demoting/promoting items 134

M
manual column breaks 107
manual page breaks 101
manual section breaks 102
margins, changing 31
matrix diagrams, creating by using 

SmartArt 186
Microsoft Office Clipboard 75
Microsoft Office Open XML Formats 57
Microsoft Word documents

adding properties 51–52
checking for accessibility 63–64
checking for compatibility 65–67
commands for working with 6–7
correcting compatibility issues 68
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paragraphs

creating blank 10–11
creating from templates 10, 12
default template 87
displaying style area pane 91
dividing into sections 32, 99–101
Document Inspector 61–63
formatting in columns 104–106
hyphenating words 33
inserting hyperlinks 23
inserting text from other files 75
inspecting for issues 61–63, 66–68
maintaining backward compatibility 68
modifying page setup 29–30
modifying properties 51–52
navigating through 2–3
paragraph spacing 87
printing 56–57
properties 51–52
saving in alternative file formats 57–61
section breaks 99–101
themes 34

N
native file formats 12
navigating in documents 2
nonbreaking spaces, inserting 33
numbered lists 

See also bulleted lists; lists
alignment 135
changing number format of 134
continuing numbering of 136
creating 133–134
defining custom format 134–135
restarting numbering 136
setting starting values 137

numbering
continuing 136
number formats 133
restarting 136
styles 135

O
objects

adding alternative text to 184–185
applying built-in styles to 176
finding 17, 19
moving 181
positioning absolutely 183
positioning on pages 179, 182
positioning relatively 183
resizing 182
rotating 182
text wrapping options 183

online images, inserting 168
orientation, changing 31

P
page backgrounds, formatting 41–42
page breaks

See also section breaks
forcing 102
inserting manually 32, 101
removing 104
section breaks 99–101
soft page breaks 99

page layout, section breaks 99–101
page margins, changing 31
page numbers 38, 40

changing formatting of 41
preformatted, inserting in headers/

footers 40
page orientation, changing 31
page size, changing 31
pages, positioning objects on 182
paper source, specifying 57
paragraph spacing 85
paragraph styles 87, 91
paragraphs

indenting 84–85
indenting multiple 86
setting spacing 86
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paste options

paste options 76
pasting content 75–77
PDF (.pdf) files

editing in Word 12–13
saving as 61

picture diagrams, creating by using 
SmartArt 186

picture frame style, applying to 
images 177–178

pictures
applying artistic effects to 177
discarding changes 179
removing background elements 

from 178–179
using as watermarks 42

Portable Document Format See PDF
positioning

images 179–181
objects 179, 182–183

preformatted image styles 175
preformatted object styles 176
preformatted text boxes 170
prerequisites, exam 2–5
printers, selecting 56
printing

double-sided documents 57
multiple copies 56
multiple pages per sheet of paper 57
scaling pages to specific sizes 57
specific portions of documents 57
specifying paper source 57

print settings 55–56
process diagrams, creating using by 

SmartArt 186
properties

adding authors to Author property 52
setting/changing Title, Tags, or Comments 

properties 51
pyramid diagrams, creating by using 

SmartArt 186

Q
Quick Access Toolbar

adding commands 48
changing command order 49
changing location of 48
customizing 46–47
document-specfic 48
removing commands 49
resetting to default 49
separating commands 49

R
reference markers, formatting manually 144
relationship diagrams, creating by using 

SmartArt 186
relative positioning of objects 183
replacing text 77–79
resizing objects 182
rows, table

See also columns; table
changing height of 124–125
deleting 121
inserting 120
resizing 121

rulers, setting indents by using 85

S
screen captures 168–169
screen clippings 169
screenshots See screen clippings
search parameters 16–17
searching

formatting marks and breaks 17
objects 17
and replacing text 78–79
restricting text results 18–19 
special characters 17
specific characters 20
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table cells

specific objects 19
specific text 18, 20
using wildcard characters 17, 20

section breaks 99–101
See also page breaks
displaying 100–101, 104
inserting 102
removing 104

sections
dividing documents into 32
specifying settings 103

shading
pictures 178
SmartArt graphics 190
tables 115, 116

shapes 164–165
See also graphic elements; images; 

SmartArt graphics
adding text to 166
adding to SmartArt graphics 189
applying effects to 191
changing angles of 166
changing colors of 191
changing forms of 166
changing hierarchy in SmartArt 

graphics 192
changing vertices of 166
customizing 190
drawing 166
formatting 174–175
moving in SmartArt graphics 191
removing from SmartArt graphics 189

size handles 111
SmartArt graphics

adding shapes to 189
adding text to 187–189
applying built-in styles to 191
applying effects to shapes in 191
changing colors of shapes in 191
changing hierarchy of shapes in 192
changing layout of 192
choosing layouts for 187–188
creating 188

demoting/promoting shapes in 192
modifying contents of 191–192
moving shapes in 191
removing shapes from 189
resetting to default formatting 191
resizing 189

soft page breaks 99
sorting table data 118–119
spaces, inserting nonbreaking 33
spacing, of paragraphs 86–87
special characters

inserting 72–73
searching on 17

splitting windows 49–50
style area pane 89–91
style sets

applying 36
resetting to template default 37

styles 
See also built-in styles
bibliographies 144–145
characters 87
clearing 96
displaying categories of 90
paragraphs 87
table of contents 155
tables 115–117
viewing available 88–89

Styles gallery, modifying 91
symbols

inserting 72–73
keyboard shortcuts for 72

T
table cells 

See also columns; rows; tables
alignment 126–127
configuring alignment of 125–126
configuring margins 125
configuring spacing of 125–126
dividing 127
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table columns

editing 118
emphasizing elements 116
formatting 116–117
formatting text in 116
gridlines, displaying/hiding 116
header rows, repeating 128
headers, copying 128
modifying structure of 119, 123
moving 120
resizing 121–122
resizing elements 123
selecting elements of 123–124
sorting data in 118–119
specifying width by using AutoFit 113–114
splitting 127–128

template, document
default template 87
displaying style area pane 91
dividing into sections 99–101
formatting in columns 104–106
inserting text from other files 75
navigating through 2–3
paragraph spacing 87
section breaks 99–101
Document Inspector 61–63, 66–67

text
adding to shapes 166
adding to SmartArt graphics 187–189
applying built-in styles 87–91
changing direction in text boxes 172
converting to tables 112–114
flowing around objects 183
formatting 82–83
formatting as columns 105
formatting in tables 116
formatting into columns 31
hyphenating words 33
inserting from another file 75
inserting in text boxes 172
positioning objects within 179
removing highlighting from 96
replacing 77–79
restricting search results 18–19

table cells (continued)
merging 127
splitting 127

table columns 
See also cells; rows; tables
built-in configurations 106
changing width of 124–125
deleting 121
displaying lines between 107
formatting text as 104, 106
inserting 120
manually breaking content 32
preset configurations 106
resizing 121
reverting to single column 107
and section breaks 105

table gridlines 111
table of contents (TOC)

changing style of 155
creating 154
deleting 156
selecting 154
updating 154–155

table properties, configuring in the dialog 
box 122

See also tables
table rows 

See also cells; columns; tables
changing height of 124–125
deleting 121
inserting 120
resizing 121

tables 
See also table cells; table columns; table 

rows
activating for editing 118
applying styles to 115–116
built-in styles 115–117
changing size of 123
converting text to 112–113
converting to text 114
creating 110, 113
deleting 121
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zoom settings, changing

searching for 16–20
selecting 4
shortcuts, adding to AutoCorrect 74
specific, locating 18
using as watermarks 42

text boxes
changing text direction in 172
formatting 174–175
inserting 170
inserting custom 172
inserting predefined styles from 

gallery 171
inserting text in 172

text strings, automatically inserting 73–74
text wrapping options 179–181
themes

applying 35
built-in 34
changing 35
modified, saving 35

time, inserting in headers/footers 39
TOC (table of contents)

changing style of 155
creating 154
deleting 156
selecting 154
updating 154–155

U
unsplitting windows 50

V
views, document

changing 44–45
customizing zoom settings 45–46

W
watermarks 41

using pictures as 42
using text as 42

webpages, inserting hyperlinks to 22
wildcards

characters 20
using in search 17

windows, splitting/unsplitting 49–50
WordArt objects 92

changing container shapes 95
creating 93–94
formatting containers 95

WordArt text
changing direction of 95
formatting 94

X
XPS files, saving as 61

Z
zooming 46
zoom settings, changing 45


	Cover
	Title Page
	Copyright Page
	Contents
	Introduction
	Taking a Microsoft Office Specialist exam
	Exam 77-725 Microsoft Word 2016
	Prerequisites

	3 Create tables and lists
	Objective 3.1: Create tables
	Create tables from scratch or from text
	Apply table styles

	Objective 3.1 practice tasks
	Objective 3.2: Modify tables
	Sort table data
	Modify table structure

	Objective 3.2 practice tasks
	Objective 3.3: Create and modify lists
	Create and manage bulleted lists
	Create and manage numbered lists

	Objective 3.3 practice tasks

	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	K
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	X
	Z




